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Images

Images are powerful and effective aid in communication. Whether on a printed
page or in a multimedia presentation, an image adds meaning and enhances
understanding. This chapter looks at organising, editing and preparing images for
use in print and on the screen.

What is a graphic image?
A computer graphic image is made up of lines, curves and shapes that can be
created, saved, altered, displayed and printed. The type of image generated,
displayed and used depends on the:

• software used to create or capture the image
• output device on which the image is to be displayed—a computer monitor, the

Internet or a printed hard-copy
• type of computer used to create and display the image.

Sources of graphic images
Images can be:

• created using graphic programs
• scanned from a hard copy
• downloaded from a digital camera 
• captured from a computer screen
• captured and downloaded from a digital video camera.
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Figure 8.1
A Canon
Powershot G6
digital camera that
includes a zoom
lens and can shoot
video



126 First Byte

What are the features of graphics programs?
All graphics programs have the following features:

• a drawing or painting window in which an image is created or modified
• a palette of tools for creating, modifying and enhancing the image
• the ability to move, copy and resize parts of the image.

There are a wide range of graphics programs available. This chapter will discuss
the Adobe Photoshop Elements and Corel Draw graphics programs.

Image files
Every image has a variety of features. Most images will be edited in some manner
before use. The way in which the image will be used is a key factor in deciding
how that editing will be done and the file format used to save the image.

Table 8.1 Features and how they may impact the use of the image for print or on the screen

Feature Definition Comment Use in print Use on screen

size image size as image size depends larger file size is smaller file sizes are 
measured in kilobytes on the settings of usually used to suitable for 
or megabytes the camera or ensure high quality monitors and the 

scanner print image Internet

dimensions the height and width dimensions affect the page breaks often the larger the 
of an image is amount of area on affect the size and dimensions, the 
measured in pixels the screen or page placement of images more time it will 

that the image will take an image to 
need download

resolution the quality of the print is measured in 300 and 600 dpi are 72 ppi is usually 
image, measured by dpi, screen measured commonly used used
ppi (pixels per inch) in ppi
or dpi (dots per inch)

file format different file formats quality of image a tif format image is a jpg format image 
for used for printing needs to be higher suitable for print is suitable for screen 
or on screen for printing than on or the Internet

screen

file name file names should give the file a name 
be meaningful related to its content

file location folder in which the transfer the image image file will be image is accessed 
image is located to a suitable folder included as part of from its location 

the document, for display
increasing file size

Tips for using images
• images should be related to the content
• the better the original image quality the better the final image
• keep the original copies of images until final editing is complete
• final editing should be completed using image editing software, before placing

into a document, presentation or web page
• use clip art sparingly.
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Digital cameras and images
A wide range of digital cameras are available with many different features. The
cameras vary in size from compact to large, high performance cameras that are
used by professional photographers.

Digital cameras offer a range of image setting modes. The settings affect the
style and quality of image created, particularly file size and resolution.

Figure 8.2 shows the modes for a Canon camera.

Downloading images from a digital camera
Most digital cameras include image management software that allows the
downloading and printing of photographs. The camera is connected to a
computer using either a USB cable or a firewire cable.

Some cameras include storage devices that can connect directly to a computer.
These include:

• compact flash memory cards
• floppy disks
• removable hard disks
• USB Storage devices.

Some cameras can also connect directly to printers to print the
photographs.

Downloading images and filenames
Digital cameras give images a default name, usually with some
form of sequence. The default name does not have any
relationship to the content of the image. Figure 8.3 shows the
filenames of series of images before download.

When these are loaded onto a computer, they 
should be stored, edited and renamed.

Figure 8.2
Canon camera
settings

Figure 8.3
Images on a digital camera
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Organising images
Viewing and organising images is a function of most imaging software. Photoshop
Elements has a File Browser. This is accessed by choosing Browse from the File
menu.

Figure 8.4 shows the File Browser with the window showing the directory, the
details of the doll.tif image and thumbnails of the images in the same folder.

Renaming a batch of images

Photoshop Elements has the
ability to rename and resize
a batch of photographs. This
is particularly useful if you
have imported a large
number of files from a
digital camera and would
like to be able to manage
them more easily.

The Batch command on
the File menu brings up the
window shown in figure 8.5.

Batch Rename allows a
folder of images to be
renamed. Batch means that
all images will be renamed
with one command, rather
than one image at a time.

Figure 8.5 Carrying out batch commands using Adobe
Photoshop Elements

Figure 8.4
File Browser in
Photoshop
Elements.
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Image composition
Common editing tasks that affect image presentation are:

• cropping—removing part of the image
• colour correction—adjusting the lightness and brightness of the image
• adding filters and special effects, such as creating a vignette.

Image size
The size of an image is important, particularly if it is to be used on the Internet.
Images to be used on the Internet should be saved with the .jpg extension.

When saving an image in Photoshop Elements, the user is given the
opportunity to specify quality options that directly impact on the file size, as
shown in Figure 8.6.

The difference in file size can be significant; for example, a 3.29 Mb tif file was
converted to an 86 Kb jpg image using the above process.

Scanners and images
Just like digital cameras, scanners can
capture images in a wide range of sizes
and formats. Scanners are purchased
with their own versions of software to
operate the scanner and to capture and
edit the images.
For example, the Epson Smart Panel
software is supplied with Epson scanners.

Figure 8.6
Setting the file size
in Photoshop
Elements

Figure 8.7
An Epson 4870
scanner.
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This allows the user a range of scanning options and is designed for ease of use.
As well as capturing images, it can carry out optical character recognition (OCR),
which can store scanned words as text for use in a word processor.

As with a digital camera, a scanner can be set to scan at a range of different
resolutions and sizes. Figure 8.9 shows the resolutions available using an Epson
2480 scanner.

Figure 8.8
The Epson Smart
Panel

Figure 8.9
Settings on an
Epson scanner
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Adobe Photoshop Elements can also access images directly from a scanner. This
can be done when starting Photoshop Elements by choosing Connect to Camera or
Scanner. This brings up the scanner window as shown in Figure 8.10 and then puts
the scanned imaged directly into Photoshop Elements ready for editing.

Copying the screen
It can be useful to capture all or part of a screen display and then edit it. The
image on the screen of a Windows computer can be captured by pressing the
PrtSc key, (top row of the keyboard, above the function keys). The image is
captured to the Clipboard and it can be pasted into a graphics program.

To edit the image, start Photoshop Elements and choose Paste from the Edit
menu. This image is now pasted into Photoshop Elements. Figure 8.11 shows a
screen dump of the Microsoft Word menu showing the commands to insert
an image.

Figure 8.10
Using a scanner
from Photoshop
Elements

Figure 8.11
A screen dump
pasted into a new
Photoshop
Elements document
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Capturing a frame from video
Capturing a frame from a video and then editing it and using it can also be
useful. Photoshop Elements can view a ‘movie’ and allow the grabbing of a frame.
This is done using the Import command on the File menu and selecting the Frame
from video option.

Computer displays and pixels
A computer display is made up of picture elements called pixels. Pixels are a grid
of x and y coordinates arranged by the computer operating system. Information
on the screen is stored and displayed pixel by pixel by the computer. 

Screen displays for most computers range from 72 to 96 pixels per inch (ppi),
the most common being 72 ppi. Images that are primarily for use on a computer
display can be stored at a resolution of 72 ppi.

Common image file formats
Image editing software usually saves files in its own proprietary format. The
software also allows a ‘save as’ to more common file formats. For example, Adobe
Photoshop Elements saves its files with a .psd extension.

Figure 8.12
A movie trailer
being played and
the ‘Grab Frame’
button
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Table 8.2 Image file formats

Use File Full name Specialisation Key features
extension

Internet/ .jpg Joint Photographics continuous tone images can display millions of colours,
digital Experts Group such as photographs from has varying levels of compression 
cameras digital cameras or the that can affect quality. During 

Internet compression unwanted 
information is discarded.

Internet .gif Graphic Interchange flat colour images, such as maximum 256 colours, can have a 
Format cartoons and animations ‘transparent’ background, can be 

animated

print .tif Tagged Interchange good quality printing high resolution for scanned 
Format images and print outs

print .bmp Bit Mapped windows use on Windows clip art, screen presentations,
paint format operating system painting own pictures in 

Windows

print .psd Adobe Photoshop photoshop image format preserves layers and other file 
details

print .cdr Corel Draw corel image format

print .fhll Freehand vector graphics diagrams and drawings

Bit mapped images

Digital photographs and images are stored pixel by pixel or ‘bit mapped’. As an
image is shown at a higher resolution, the pixels become more apparent.

Figure 8.13a shows an image, Figure 8.13b shows part of the same image
magnified to 1600%. Each of the pixels forming part of the image can be seen.

Figure 8.13a Figure 8.13b
Images at different resolutions
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Vector graphics

Images such as those created in drawing and illustration programs are stored as
mathematical relationships and are only translated into pixels for display on the
screen. The image itself is an object and when selected on screen it appears with
‘handles’.

Table 8.3 Bit map versus vector images

Bit map (pixels) Vector graphics

description image information stored for each screen information about the image is stored as a 
‘pixel’.The image is like a mosaic. mathematical formula

file formats bmp, tif, jpg, gif swf

examples clip art, photographs and digital images, images created with specialist illustration and 
movies drawing software, diagrams

suitability suitable for continuous-tone images; shades smaller file sizes for high-resolution drawings 
and colour variations can be subtle and diagrams

scaling image has fixed size; enlarging can distort image can resized without loss in quality
image

use onscreen most monitors display 72 ppi to 96 ppi; some Internet browsers cannot show vector 
individual pixels show onscreen graphics without suitable plug-ins; as monitors 

use pixels for display, vector grapics may appear 
pixellated at high magnification

use in print quality depends on dpi of the image, should no loss of quality when printed
be greater than 150 dpi for printing

Some software such as Macromedia Flash and Photoshop Elements can open
and use either format. However if paint tools are to be used then the image will
need to be converted to a bitmap image.

Editing text as an image
Text can be entered and treated as editable text in some image editing software.
Figure 8.14 shows some text entered in Photoshop Elements.

If the file is saved in some formats, such as gif or jpg, the text object will be
converted to bitmap shapes and only able to be edited using Windows paint tools.

Dimensions of images
An image can be altered by resizing and cropping. Resizing alters the size of the
image by setting the pixel dimensions or by setting a percentage size of the
original image.

Figure 8.14
Editable text in
Photoshop
Elements
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Figure 8.15 shows an image that has been resized, figure 8.16 shows the
dialogue box, selecting Resize on the Image menu and then Image Size from the
Image menu. The new width and height can be entered either as a pixel value or
a percentage.

Cropping removes part of the image that is not necessary. Figure 8.17 shows the
crop  tool from Photoshop Elements used to select part of the image.

Figure 8.17 Using the crop tool in Photoshop Elements.

Figure 8.15
Resized image

Figure 8.16
Photoshop dialogue
box

Figure 8.17
Cropping in
Photoshop
Elements
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Image editing effects
The quality of an image can be adjusted in Photoshop Elements. Some common
tasks include altering:

• the lightness and brightness
• the brightness and contrast
• the resolution of the image in pixels per inch.

Photoshop Elements tools
Figure 8.18 shows the toolbox available in Photoshop Elements.

Applying image filters and effects

Photoshop Elements has a variety of pre-defined filters and effects
that are ‘one click’ applications. These are used to enhance images
or to create special effects.

Figures 8.19 and 8.20 show applying a Vignette effect to an image.
The selection has been performed with the Eliptical Marquee tool
from the toolbox. The Vignette effect was then applied.

Figure 8.18
Tools in
Photoshop
Elements

Figure 8.19
Eliptical Marquee

Figure 8.20 The
vignette effect
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Using layers

Layers are another useful feature of some image editing and graphics software. It
is rather like using separate sheets of glass. Layers can be:

• shown or hidden
• locked or unlocked
• merged with other layers
• given names or left with the default ‘Layer’ number
• used to test image effects and adjustments before they are incorporated into

the image.

Figure 8.22 shows some of the layers on the doll image in Photoshop Elements.
The image on ‘figure’ layer is not shown as part of the image because the ‘eye’
symbol to the left of the layer thumbnail has been unchecked.

Whether layers are preserved in the final saved file depends on the final file
format, for example, the layer information is lost if the image is saved as a .jpg
file.

Figure 8.21
Layers in an image
editing program

Figure 8.22
Image and layers
with the figure layer
not displayed on
screen.
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Saving a file for the Internet
Having determined the height and width for an image, a balance has to be found
between the quality of an image and file size. 

A larger image takes longer to download and display in. If the download time is
too long, users will not tolerate the delay and will leave the page.

As previously discussed, the best file formats for use on the Internet are gif and
jpg.

Saving a jpg

Figure 8.23 shows the Save for web dialogue box in Adobe Photoshop Elements.
There are a variety of settings that can be applied. A preview of the image can also
be seen in the browser by clicking on the Preview button near the bottom of the
window. Note that the dialogue box also gives an indication of how long it would
take to download the file from the internet using a 28.8 kbs modem.

There is a loss of image quality when an image is saved in the jpg format. This
is a result of the compression. The human eye is the best judge to determine if
the image is suitable for the web. As the compression is applied to a jpg image,
information is discarded and cannot be restored.

Creating animated gifs
A series of gif images can be used to create an animation. Each frame of the
animation is made into a separate layer in the image software and then saved. The
example below shows a simple three-frame animation for a Web banner. Only text
is used in the animation. 

Figure 8.23
Saving an image for
the Web
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Figure 8.24 shows a storyboard design, each frame of the storyboard is a layer
in the image file.

Create the file

Adobe Photoshop Elements has a preset image size file for a web banner of
468 pixels by 60 pixels. To create the file, go to the File menu, select New and
choose preset size of 468 by 60 web banner.

Figure 8.24
Storyboard design

Web bannerWeb banner : Mac’s Place
 468 pixels

60
pixels

White Background

Macʼs Place
Frame 1

Text: Helvetica
Text size: 48 pt

Your Holiday Place
Frame 2

Book now!
Frame 3

Resolution: 72 ppi

File format: Animated - gif
Animation - loop, Frame delay 1 second

Figure 8.25
Creating a Web
banner
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Each layer contains one frame of the animation. In the layer tab, each layer can
be seen separately and can be treated as if it is a separate document.

Figure 8.26 shows layer three of the animation.

When saving the file it becomes an animation by selecting the options gif then
animation with the option of loop and then setting a frame delay; the time
between the frames of the animation.

Figure 8.27 shows the dialogue box to save the animated gif.

Your turn
1 Find some examples of animated gifs on web pages. Open them in Photoshop Elements to

see how they have been created.
2 What are the advantages and disadvantages of using animated gifs on web pages?

Figure 8.26
Layer three

Figure 8.27
Dialogue box
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Draw programs
Draw programs allow you to create objects rather than bit-mapped images. The
objects may be moved around the screen and can be placed in front of or behind
other objects.

Each draw program also has a palette of tools to be used in creating images.

Colour and fills in a draw program
Draw programs also include a palette of colours and different types of fills. Fills are
used to fill the inside of a shape with a chosen pattern and colour. Patterns and
colours may often be changed within the program.

Your turn
1 Start a draw program and write down the names of each of the tools and a brief 

summary of what each will do.
2 Use a draw program to draw:

• a rectangle with rounded edges
• a freehand line.

3 Use a draw program to create rectangles, ovals, squares and circles with different fills.

Selecting an object
The selection tool is used to select objects so that they can be moved, copied,
deleted, resized or rotated.

The purpose of the ‘handles’ is to allow an object to be moved, resized or
stretched. Figure 8.29 shows an object that has been copied and then resized and
stretched.

Objects can also be rotated. Figure 8.30 shows an object that has been rotated
through 90˚.

Because draw programs work in layers, objects can be moved backwards and
forwards as shown in Figure 8.31.

Figure 8.28
Draw tools used
in CorelDRAW

Figure 8.29
Resizing an object

Figure 8.30
Rotating an object
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Objects can also be moved around in relation to one another.

Example—Creating a logo
The logo shown in Figure 8.32 was created using a draw program. The steps used are listed
below.

1 Draw a black rectangle.
2 Draw another rectangle in front of the black square, ensuring it is opaque and filled with

the same shading as the background—for example, white. This gives a shadow effect.
3 Use the text tool with a large font and bold style to enter the initials ‘GGB’.
4 Use a smaller font to enter the word ‘Enterprises’ on the next line.
5 Choose a graphic font such as Wingdings and enter a character to the left 

of the text.

Your turn
Use a draw program to make sure you can do the following:

• draw straight lines of varying thicknesses
• select an object, copy and paste it a number of times
• use the text tool to key in a sentence, select the text and try different fonts, sizes and

styles
• draw squares, both empty and filled with a pattern
• draw circles, both filled with a pattern and empty
• draw overlapping objects, select one and move it backwards and forwards.

Clip art
Clip art refers to a range of images that can be copied for use in your own
publication. Some graphics programs include clip art with the software. CD-ROMs
of clip art may be purchased. Images may also be downloaded from the Internet.

Figure 8.31
Moving objects
backwards and
forwards

Figure 8.32
Logo created 
using a draw
program

Figure 8.33
The first three 
steps in creating 
the logo
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There is a wide range of topics available including sport, education, nature and
people. Many of these are available as shareware or public domain programs.

The images are copied by selecting them with a selection tool and then using
the Copy command before pasting them into a document.

Care must be taken to ensure that copyright laws are adhered to when
publishing documents containing clip art. Some clip art is royalty free and can be
published without restriction. Some art requires royalties to be paid if it is
published. There may be different conditions for publishing in a printed
document or on the Web. Particular care must be taken when using images from
the Web as many of these have copyright restrictions.

Creating a panorama
360 degree panoramic images are common on the Web to show a place, a product
or an object. For example, a landscape can be scrolled horizontally, with some
vertical scrolling as well as zoom in and out. Real estate agents often use
panoramas to show the features of the houses they have for sale.

A panorama is created by joining together a series of images—called ‘stitching’.
A series of images should be taken using a camera with a tripod to keep a level
plane. There needs to be a degree of overlap of each image, this can be seen in
the viewfinder before the image is captured on the camera.

Figure 8.34 
Examples of 
clip art from
Microsoft Office

Figure 8.35
An image sequence
taken on a Canon
camera
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After each image is captured the camera is rotated slightly. Approximately
twelve images are needed for a 360 degree panorama.

Images can be checked to make sure they are in order before ‘stitching’ as
shown in Figure 8.37

The final image file is saved as a movie file. One format is Apple Quicktime VR
(Virtual Reality).

Figure 8.38 shows the final image saved as a movie file with controls for
viewing. The final movie is 291 pixels by 172 pixels, with a file size of 300 kb.

Figure 8.36
Image one and two
showing the
sequence for
stitching

Figure 8.37
Selection of images
before stitching,
using Canon
photostitch

Figure 8.38
Final Quicktime VR
image showing
controls
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Creating a web gallery
It can be useful to create a gallery of photographs for display on the Internet.
This can be done with Photoshop Elements using the Create Web Photo Gallery
command on the File menu. A series of web pages with the images and links is
created.

Your turn
1 Use a scanner to scan a photograph of yourself. Save the image and print it out. Save the

image in different formats—for example, tif, jpeg, gif—and see what difference there is if
the image is printed out or displayed on a computer screen.

2 Use a scanner to scan a piece of line art. Save the image and print it out. How much 
space does the file take up on the disk?

Review questions
1 List the main differences between paint and draw programs.
2 Using either a paint or a draw program, answer the following questions.

a What tool do you use to draw rectangles?
b How do you draw horizontal straight lines?
c How do you draw circles?
c What do you do to copy parts of an image?

3 What is clip art? How can it be used with graphics programs?
4 What is a scanner?
5 What steps would you take to scan a photograph?

Figure 8.39
Creating a Web
photo gallery

?
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Now try these
1 Create your own business card. A business card usually measures about 5.5 cm by 9 cm.

You will need to copy your logo and put it on the card. Business cards usually include the
employee’s name, title, company name, address and telephone number.

2 Create your own letterhead using your logo and including your name and address.
3 Draw a plan of your house.
4 Design a cover for a compact disc for an album by your favourite group. Compact disc

covers are usually 12.5 cm wide by 12 cm long.
5 Copy an item of clip art into a paint program and modify it.
6 Scan a photograph of your favourite group and use it to create an advertising flyer for a

concert.
7 Scan a logo from a magazine or newspaper. Use the logo to create a business card.
8 Use a flat-bed scanner and a hand-held scanner to scan a photograph. What are the

differences in using each of these types of scanner?
9 Use clip art in the design of a one-page flyer to promote a class party or class picnic.

▲

WORKSHEETWORKSHEET
838338388338

Create CD
packaging
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7333737733

Design a
business card


